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Using the eVSM User Guide

Dear Lean Practitioner,

The eVSM user guide is intended as a summary of eVSM 
functions for working with Value Stream Maps, Spaghetti 
Diagrams, Communication Circles and A3 Reports. 

The user guide has convenient indexing at the back for 
toolbar functions, eVSM Icons and keywords.

The eVSM help site at www.evsm.com/help has a learning 
path and additional materials that will help you be productive 
with the eVSM software.

We very much appreciate any improvement suggestions for 
our learning materials and/or software and ask that 
suggestions be emailed to us at support@evsm.com. We look 
forward to hearing from you.

Thank You,

eVSM Support
support@evsm.com
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eVSM Environment

Start eVSM

The best way to start a blank value 
stream map is to double-click the 
eVSM icon on your desktop. 

Starting eVSM

If your Visio security setting is set to anything but low, 
messages will come up asking for permission to “Enable 
Macros”. You must answer “Yes” to these messages for 
eVSM to operate

eVSM Pre-requisites and Updates

eVSM requires Visio (2002 or later) and Excel to operate. 
eVSM is downloadable and you can check on the latest eVSM 
version available at:

www.evsm.com/updates

Help Movies

These and other short movies on eVSM are available at 
www.evsm.com/help 

Start Draw 
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eVSM Toolbar

The eVSM toolbar is located just above the drawing page. If 
this is not visible than the eVSM software is not properly 
installed or the Visio security setting on your system is 
preventing running of the macros that create the toolbar.

For information on each of the buttons, see the “Toolbar 
Button Index” at the back of the user guide

eVSM Help

The help button on the toolbar requires an internet connection 
and will open up a web browser pointed to the eVSM help site 
at www.evsm.com/help

The help site is tested with the IE browser and this is 
recommended if there are any browsing problems

eVSM Help Site

eVSM Support

We offer technical support for the latest release of the eVSM 
software. Please email us at support@evsm.com

...
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eVSM has a collection of value stream 
mapping shapes that appear in eVSM stencils
to the left of the drawing page.

These shapes, behaviors, and corresponding 
functions have been designed from the outset 
to support the series of lean workbooks from 
the Lean Enterprise Institute (www.lean.org) , 
the Lean Enterprise Academy 
(www.leanuk.org) and their worldwide network 
partners. The primary workbook impacting the 
design has been “Learning To See”

As the software usage has become 
widespread across multiple industries, the 
icon language has been extended to keep 
pace with practitioner requests. For Lean 
Healthcare, it now supports the “reVIEW” 
manual developed by Lean Healthcare West 
(www.leanhealthcarewest.com).

To make it easy to navigate the 
comprehensive set of shapes they have been 
organized in family stacks (blue icons in the 
stencil) and into the subset stencils below: 

eVSM Shapes & Stencils

eVSM v4.22

eVSM Mfg

eVSM Service

eVSM Healthcare
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Re-opening eVSM Stencils

eVSM stencils must be kept open. If you have “lost” the eVSM 
stencils from your drawing file, here are the steps to re-open 
them.

In Visio, click:

File > Shapes > Open Stencil…

Navigate to the following folder:

C:\Program Files\GumshoeKI\Visio2002\Setup\Solutions

Select all the stencil files (*.vss) in this folder and then 
click the Open button.

Save your Visio file.

CTRL-W (to zoom out to whole page)

CTRL-SHIFT-Drag Select region (Zoom into the selected 
region)

Try the Visio menu “View > Pan and Zoom” for another 
navigation option with a mini-window

To set up the mouse scroll wheel to zoom, use the Visio 
menus: “Tools > Options > General” and check:

Zooming In and Out

Zoom on roll with InteliMouse

Center selection on zoom
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Hold down the CTRL key and move the cursor to the edge of 
the page. The cursor will turn into a double-headed arrow. 
Just grab the edge and pull to required size.

Page Resizing

Avoid the page corners when re-sizing the page. The page 
corners allow rotation of the drawing page. However, there is 
a Visio bug which can corrupt the drawing file if the page is 
rotated.
If you rotate the page accidentally, then use "Edit>Undo" to 
recover. If it is too late to Undo, then copy/paste the drawing 
content to a new page.
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Drag & Drop

Outside
Source

Drag and drop eVSM icons from the 
stencil onto the drawing page

Blue icons represent stacks of shapes. 
Access the stack by dragging out the 
shape and then clicking the right 
mouse button

Resizing Shapes

Shapes are designed to be grid-sized. The drawing page has 
a grid on it. Use View > Grid to turn grid visibility on. Snap 
shapes to grid locations for easy alignment

Double-click a shape to edit its text

Text Editing

Cross Dock
In_Store Storage
Moment_Of_Truth
Picture Process
Process
Process Cell
Production Control
Rework Process
Shared Process
Warehouse

Process

Snap To Grid

Avoid resizing shapes whenever possible. Shapes are 
designed to fit together and resizing a shape will make “fit” 
difficult and create extra work.
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ValueName Unit

ValueName Unit

Connecting Shapes - Glue

eVSM shapes have built-in connection points on their 
boundaries that allow them to be glued together. Gluing 
shapes together has two uses:

It makes modifying the map simpler because moving a 
parent shape causes the child shape to move with it

eVSM infers association between shapes by looking at 
the parent-child glue connections between shapes

Process

Process

Visio shows a glue connection at the 
point of gluing with a red box. So 
when the arrow head is moved to a 
point where Visio is about to glue it 
to the lower process block, a red box 
is temporarily displayed

Process
Similarly for this situation at the point 
where you move a data shape to the 
bottom of the activity shape

Process

When a child shape is glued to a 
parent and you select the child 
shape you will see some red dots on 
its periphery to indicate that it is 
glued..

eVSM Glue Check On/Off

Toggle the glue check button in the toolbar for a visual display 
of the glue connections
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Manipulating Text

All shapes in Visio can have their own text. This includes 
eVSM connector arrows. 

Text Block Tool

Caution: Be sure to de-select the Text Block Tool when 
finished. 

Tex
t on

 Co
nne

cto
r

Twice per 
week

Double-click a shape to edit its text.

The Visio Text Block Tool, located 
behind the Text Tool in the Visio 
Standard toolbar, can be used to move 
the text relative to the shape location.

The Text Block Tool displays control 
handles around the text belonging to a 
shape. These control handles can be 
used to position and size the text block

Twice per week

Twice per 
week
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Copying Shapes

You can select a set of shapes and then use
EDIT > COPY followed by EDIT > PASTE

Another method is to select the set of shapes and then 
holding the mouse over the geometry of one of the selected 
items use CTRL-Drag to make a copy

Undoing Mistakes

The Visio toolbar has an “undo” button to reverse any 
mistakes

Visio Page Names

Rules for Visio drawing page naming:

Page names must start with an alpha character

Page names must be limited to 0-9 and A-Z characters. 
Characters such as [!@#$%^&*()|+-?] are not allowed

Page names should be kept as short as possible 
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Recommended Do’s and Don'ts

DO Glue Everything and use Glue Check button

DON’T  Resize eVSM Shapes wherever possible

DO Snap shapes to grid location 

DON’T  Close eVSM Stencils

DO zoom in fast with CTRL-SHIFT-Drag  

DO zoom out fast with CTRL-W  

DO Use a mouse to be productive with eVSM
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Identify the operations in the value 
stream and starting at the 
customer end. 

Use the Right Mouse button if you 
need to swap to another process 
shape.

Identifying Operational Steps

Process

Operation 
Shapes

Drawing Value Stream Maps 

Customer

Identifying Customer

Outside 
Source

Start the map at the 
customer end. 

Help Movies

These and other short movies on eVSM are available at 
www.evsm.com/help 

Drawing the Flow

Add Map Data Hyperlink Maps

Autofix Function Automove Function

Manage Names & Units
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Process

Process

Drag out, drop and then glue 
arrows to the operations or their 
data shapes for easy future 
modification of the map

Use the Right Mouse button to 
swap to another arrow type (like 
this PUSH arrow)

Connecting Operational Steps with Arrows

Stepped 
Arrows
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ValueName Unit

Adding Operational Data

Data shapes must be glued 
directly, or via other shapes, 
to the activity they represent.

Process

Value stream data which you may later want to use in 
calculations, must be represented in eVSM data shapes. 
eVSM has the following data shapes.

ValueName Unit

Value

Name

Unit

Value Unit Value Unit

Long NVU Short NVU Value 
Added

Non Value 
Added

Data shapes consist of two or three fields. To move or delete 
a data shape, you MUST click on the Value field. To edit any 
of the fields, just double-click on it. The value field can be 
edited directly through double-click. Double-clicking on the 
Name or the Unit field will open a pop-up selection list.

ValueName UnitValue

Name

Unit

Value Unit

Value Unit
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Variable Names and Units

eVSM Name and Units Manager

To add variable names/units to the right mouse button (RMB) 
menus, follow these steps:

1.Click the following button in the eVSM toolbar button to 
open the Name & Unit Manager (NUM) dialog.

3. To add a new unit, click the “New Unit…” button.

4. All variable names must have a default unit. When adding 
new variable names, first make sure that the unit you wish 
to make the default for the new variable exists in the units 
list. Then, click the “New Name…” button and follow 
prompts.
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3CO min

20CT sec

3CO min

20CT sec

Process
Additional data can be added to a 
process. Drag & glue new NVU’s  
to the bottom of existing NVU’s. 

Process

Data shapes that do not touch the 
operation or its data shapes 
directly should be associated with 
the operation by dragging the 
flying yellow connector and gluing 
that to the operation.

Flying connectors should NOT be 
used where shapes are touching

Adding Additional Data Shapes

Long 
NVU

xx
Day
s

xx Unit

Process

VA and NVA shapes 
are available to 
construct a timeline 
on the map.

Glue these shapes to 
operational shapes 
with a flying 
connector

Process

Representing VA & NVA data

Where there are several VA/NVA 
metrics to be tracked, the Long NVU 
shape should be used instead of the 
specific VA, NVA shapes

Value 
Added 

Non Value 
Added 

x.xx Unit
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20

LH

plts

20

LH

plts

Supermarket and Buffer shapes 
work in a similar way to the 
inventory shape. Any data must be 
glued to the base of the shape

Representing Supermarkets and Buffers

Short NVU

Supermarket

Drag out the NVU shape and glue it to the 
bottom of the inventory rectangle to 
document inventory type and quantity. Use 
additional triangles and NVU blocks for 
each inventory type.

Each inventory item associated with any 
one operation MUST have a different name.

Representing Inventory Data

Short 
NVU

Inventory shapes should be placed on the 
drawing and the flying yellow connector 
used to glue them to an operation.

Use the Right Mouse button to swap to 
another inventory shape (like queue, in-
tray etc..)

Representing Inventory & Queues

Inventory 
Shapes

Process Process
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Drag out transport shape and 
place them on the map. Glue 
them to arrows as an option. 
NVU shapes to hold related 
variables can be attached to 
the base of the  icons

Use the Right Mouse button to 
swap to another transport type 
like train, helicopter etc..

Representing Transport Method and Data

Process

Transport 
Shapes

Finished 
Goods

Representing Transmit Method and Data

Transmit shapes work 
in a similar way to 
transport shapes and 
are generally applied 
to information flow.

Transmit 
Shapes
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The Units shape in the stencil is used to 
define conversion factors between units in 
each family. If a single variable on the map 
(like Cycle Time) has data values in different 
units (like Hrs and Mins) then conversion 
factors must exist linking these units.

This is an example of a “time” unit family. In 
eVSM the first letter of a unit name is 
sometime used as its abbreviation so its 
important that no two members of the unit 
family have the same first character. Note the 
use of “PSfts” (instead of “Shfts”) to avoid first 
letter conflict with the “Secs” unit

Using Unit Converters

Units 
Converter

Frameless Transport & Transmit shapes

Transmit 
Shapes

By Foot
Computer
Fax
Pager / Radio
Phone
Post
Print
Web Form
_______________
Framing

Right-click on the transmit (or 
transport) shape on the map to 
show alternate transmit 
methods.

At the bottom of these is a 
“framing” menu pick that 
allows the outer box around 
the shape to be turned on or 
off. When turned off the shape 
looks as below:

15

Days

Hrs

60

Hrs

Mins

60

Mins

Secs
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Multi-Unit Variable Display

Lets you show data values in a combination of related units. 
Available in Long and Short NVU’s shapes only. Example:

60

Hrs

Mins

60

Mins

Secs

16

Days

Hrs

2.753Cycle Time Hrs

Normal Display

2h 45m 12sCycle Time

Multi-Unit Display

The Multi-Unit Display switch is in the Name Unit Manager:

Multi-Unit Display is available only for 
units for which Units Convertors are 
provided on the page

Multi-Unit 
Display switch
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Allows you to enter and edit data values in a combination of 
related units. Available in Long and Short NVU’s shapes only. 
Steps:

x.xxCycle Time Hrs

Enable Flying Connector
Multi Unit Edit

2.753Cycle Time Hrs

60

Hrs

Mins

60

Mins

Secs

16

Days

Hrs

Multi-Unit Edit

1. Setup Units Convertors for the related units

2. Right-mouse click on the value field of the NVU and 
select the “Multi-Unit Edit” command

3. Enter values in the Data Entry form

4. See the result in the NVU
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Automove

Automove makes it easier to insert/remove activities from 
large makes. The function consists of two buttons

eVSM Link Activities

eVSM Unlink Activities

When the Link Activities button is clicked, all activity shapes in 
each flow line are linked (rigidly locked) to each other. In this 
mode, if any activity block is selected and moved, it gets 
unlinked from the upstream activity. All the downstream 
activities stay linked and move with it.

The Unlink Activities button is used to exit this mode. It is 
active when the shapes are in the linked mode.

Steps:

1.Click the eVSM Link Activities button

2. Select and move activity downstream of where space 
needs to be created or removed

3.Click the eVSM Unlink Activities button to exit Automove 
mode

Move
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Autofix

Autofix corrects some common problems on maps. To run, 
click this toolbar button.

Problems fixed by the Autofix function include:

Removes hidden data shapes. Sometimes when using 
copy/paste, multiple copies are created and duplicates 
hidden under visible data shapes. Finding and removing 
these can be tedious. Autofix automatically deletes such 
duplicates

Automatically glues data shapes and arrows based on 
proximity

Works around the Visio glue limitation of 10+ shapes

eVSM Autofix

Before After
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Text on 
Connector

Text on 
Connector

Manipulating Text on Connectors

Text can be added to any connector by double-clicking and 
typing.

The Visio Text Block Tool can be used to move the text 
position along the arrow.

Text on 
Connector

Text Block Tool

Caution: Be sure to de-select the Text Block Tool when 
finished. 
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Creating Drill-Down Maps

The eVSM Drill Down button in the toolbar can be used to 
create a sub-page corresponding to an operation shape on 
the map. First pick the operation shape and then click the drill-
down button. A hyperlink is automatically created from the 
operational shape to the sub-page

eVSM Drill Down

Migrate Maps to eVSM v4

eVSM V4 Migration

The following button in the toolbar will migrate eVSM v2 and 
v3 maps to eVSM v4 format.

Once a map is migrated to v4, it cannot be opened in older 
releases of eVSM.

If you need to open an eVSM v4 file in, say v3 (or any earlier 
version of eVSM), for viewing/printing purposes only, here is a 
workaround.

1. Start eVSM and switch VB Macros Off. Click “Tools > 
Options > Security”

2. Switch Off this
checkbox

3. Exit Visio and open the eVSM v4 file.

Remember to reverse step 2 above when you wish to use 
eVSM v4 again.
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Drawing a Key of Icons

The eVSM Key Creator tool generates a Key of the icons 
used on the current drawing.

Drag out the Key Creator icon and drop it in the space on your 
map where you want to display the key. 

Note: This automatic function is restricted to eVSM shapes on 
the current drawing page. Some eVSM shapes, eg. 
datashapes such as long and short NVU’s are intentionally 
omitted.

The Key display uses the eVSM Table shape. This allows you 
to delete/add columns (see how in the “Working with Tables” 
help)  in the key and also change the annotation.

Cross 
Dock

Finished 
Goods

Inventory
Outside 
Source

Process Summary Truck
Units 

Converter
Warehouse

Key Creator
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The Spaghetti Diagram highlights wasted journeys and effort 
by visualizing motion between activity centers. The eVSM 
Spaghetti diagram function allows you to draw paths on a 
floor plan (or any geographic map) and then export a path 
report to Excel.

Drawing Spaghetti Diagrams

TO COLOR DESCRIPTION DATE TIME DISTANCE

ER Bay 9 Patient assisted in wheelchair 3/3/2007 5:36pm 102

X-ray waiting area patient escorted to X-ray waiting area 3/3/2007 6:20pm 58

X-ray Room 1 Patient to X-ray 3/3/2007 6:32pm 27

ER Bay 9 Patient returned to Bay 9 3/3/2007 6:45pm 62

Help Movies

Spaghetti Diagrams

Floor Map

Spaghetti 
Place

Spaghetti 
Path

Spaghetti 
Report in Excel
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1. Draw or import the floor map. Visio can import most 
bitmap formats as well as AutoCAD drawings.

2. Click the Spaghetti Diagram button in the eVSM toolbar. 
This will open the eVSM Diagrams stencil.

3. Drag out a Spaghetti Scale shape from the eVSM 
Diagrams, and stretch it out to exactly fit a known 
dimension on the map. The known dimension could be a 
map scale if available, or a floor dimension you have 
measured. Enter the actual dimension value on the scale 
shape.

4. Define activity centers by dropping and naming a 
Spaghetti Place icon on to the diagram for each place.

Steps To Create A Spaghetti Diagram

Spaghetti Diagram

Spaghetti 
Place

Spaghetti 
Scale

1
4
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FROM Registration

ER Bay 9TO

DISTANCE 102

SEQUENCE 1

DESCRIPTION Patient assisted in wheelchair

DATE 3/3/2007

TIME 5:36pm

C
u
s
to
m
 P
ro
p
...

Steps To Create A Spaghetti Diagram (cont'd.)

6. Use the line tools in the Visio “Drawing” toolbar to draw 
the different paths. 

You must ensure that the start and end of a path line is 
inside a Spaghetti Place icon. You can set color and line 
thickness of the paths using standard Visio formatting.

7. Click the Spaghetti Diagram button again. eVSM will 
create a spreadsheet report of the paths.

8. Additional attributes can be added to the path lines via 
Visio Custom Properties. Select a path line, and click 
View > Custom Properties.

The next time the Spaghetti report is generated, the path 
attributes will be transferred to the report.

Any of the line 
drawing tools 
can be used
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The Communications Circle allows you to visualize all the 
transactions in a given pathway or process.

Example:

Number Of Steps = 14

PHYSICIAN

PATIENT

VOLUNTEER

BILLING

SOCIAL 
SERVICES

ADMITTING

NURSE

CHARGE 
NURSE

ER UNIT 
CLERK

Drawing Communications Circle

Help Movies

Communications Circle
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1. Follow a pathway or process and record all transactions 
in an Excel table in the following format. The first row in 
the spreadsheet must contain the column headers as 
shown. Save the Excel file anywhere on your machine.

Steps to Generate a New Communications Circle

FROM TO

Registration Patient

Registration Nurse

Nurse Patient

Nurse Unit Clerk

Physician Patient

2. In eVSM, click the Communication Circle button in the 
eVSM toolbar. This will open the eVSM Diagrams stencil.

3. Drag out a Communications Circle shape from the 
eVSM Diagrams stencil. This will create a blank circle 
on your drawing. Adjust position and size the circle as 
you like.

Communications Circle
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4. Click the “Import Communications From Excel” command 
in the right-mouse-button menu of the circle.

5. Select Excel file and click OK. Note, if you have more 
then one worksheet in the Excel file with communications 
data, then you will be prompted to select the worksheet to 
use.

The communications circle may be edited directly in Visio. 
You can change, add, or delete circle members. You can 
move, add, or delete communication paths. Communication 
paths can also be color coded to show different types of 
communications, eg. Phone, fax, patient initiated, etc.

After making changes, use the “Update Number of Steps” 
command in the right-mouse menu to update the number of 
steps.

Editing a Communications Circle

Steps to Generate a Communications Circle (Cont'd)

Import members from Excel
Import Communications From Excel

Export Members To Excel
Export Communications To Excel
Update Number of Steps
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Importing a Circle Members List

This is useful when the members are known but the 
transactions are not. Use the “Import Members from Excel” 
command in the right-mouse menu. The Excel data must be 
in the following format.

MEMBER Y/N

Registration Y

Patient Y

Nurse Y

Unit Clerk N

Physician Y

The Y/N column is needed to specify members to import. 

Communication Path Properties

Custom properties are available on the Circle Path shape 
which may be used to capture additional details. To access 
these, right-mouse click on a path, then “Shape>Custom 
Properties…".

The “Export Communications to Excel” command in the right 
mouse menu of the circle will export all of the above 
properties to Excel. The communication path line color is 
also transferred to Excel.

C
u
s
to
m
 P
ro
p
e
rt...

SEQUENCE 4

Send patient registration details to RNDESCRIPTION

DATE 3/27/07

TIME 5:06 PM

DISTANCE Unknown

DURATION Unknown

TYPE Value Added

PATHWAY Admission
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first zoom into the appropriate area of the A3 sheet using the 
following Visio shortcuts:

CTRL-W (to zoom out to whole page)
CTRL-SHIFT-Drag-Select region (Zoom into the selected 
region)

eA3 comes with a template (below) of an A3 report and a set 
of icons to make it easy to visualize the “Current Condition” 
and “Desired State” aspects of the sheet. Click the A3 toolbar 
button to create a new report

eA3 Report

Creating A3 Reports 

Help Movies

A3 Reports
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Pr
ac
tic
e

Hospital

Hospital

When to 
Operate ?

Erratic OR Priority 
Overrides

No centralized 
booking

Insurance Impacts

A typical “Current Condition” diagram is shown above and 
can be drawn very quickly in eA3 with the icons available.

You can drag and drop a person from the stencil. You can 
change the person “role” by clicking the right mouse button 
and selecting the role (nurse, doctor, etc..). You can also set 
the person’s expression in the same way. People stacks are 
available for mfg, services and healthcare

Diagramming the Current Condition

Representing People

Healthcare 
People
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Pharmacy

Ph
ar
m
ac
y

Pharmacy

Pharmacy

Icon 
Of 
Place

You can create an iconic 
representation of a department 
and glue an icon to its center. 
You can also type in the name 

The square frame of the dept 
icon can be hidden with the right 
mouse “framing” menu for a 
simpler look

High Roof 
Place

Low Roof 
Place

Glue point for 
area icon is 
under the apex 
of the building.

Glue point for 
area icon is at 
the eaves on 
the left of the 
building

Representing Departments

Healthcare 
Depts

Healthcare 
Depts

Healthcare 
Depts
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Typically used to identify 
problemsProblem

Solution

Text

Typically used to identify 
solutions or positive attributes 
of the “Desired State”

Typically used to denote 
thoughts or verbal 
communication

See the “Draw” and “Gadgets”  sections to see how  these 
items can be used on an eA3 sheet

Problems, Solutions and Callouts

Icon Stacks

Tables and Gadgets on A3 Reports

Healthcare 
Depts

Healthcare 
People

Mfg 
People

Service 
People

Mfg 
Depts

Service 
Depts

Healthcare 
Items

Transmit 
Shapes

Transport 
Shapes

Kaizen 
Cloud

Kaizen 
Starburst

Callout
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Sq. Area 
Gadget

Tr. Area 
Gadget

Slider 
Percent 
Gadget

Arc 
Angle 
Gadget

Line Tk 
Gadget

Bar 
Height 
Gadget

Curve Tk 
Gadget

Any data on the map can be linked to visual gadgets that 
change in size and color with change in the data. Some 
gadget types are shown below:

Each gadget has exactly one size parameter that can be tied 
to a data value on the map. Here’s a typical means to apply 
and manipulate gadgets..

1. Drag out the gadget and 
position it near the data 
value with which it will be 
associated (In this case 
the “Cycle Time”)

Steps to Create Gadgets

Using Gadgets to Visualize data

Bar 
Height 
Gadget

Process

2Cycle Time Mins
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Gadget 
Data

Drag and glue the gadgets Yellow 
Flying Connector to the side of the 
NVU data shape (Avoid gluing to the 
top or bottom of the data shape).

Click on the gadget and use the 
“Activate Gadget” option on the right 
mouse button  to create a new gadget 
collection. The collection name will be 
“Bar_Cycle Time”. The name is made 
from the Gadget Type and the Data 
name

2. This system shape will be automatically dropped 
on the page the first time a gadget is used. If 
you copy a map to a new page make sure you 
also copy this shape because it is used to hold 
gadget data for the map

3. A gadget can only belong to 
one collection. Each collection 
can only have a single type 
(eg. “Bar”) of gadget

You can change gadget scale 
factors and color code them by 
modifying the properties of the 
associated gadget collection

Steps to Create Gadgets (Cont'd)

Process

2Cycle Time Mins

Process

2Cycle Time Mins
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4. You can easily create additional gadgets tied to other 
instances of the same data on the map. Just click on the 
gadget and use the right mouse button to select “Create 
Gadgets By Example” to create the gadget for Process B 
below

5. Note that the new gadget is automatically positioned, 
scaled and put into the same “Bar_Cycle Time” collection. 
If you do not wish to have new gadgets created for the 
whole map than select the original gadget, then sub-select 
an area of the map before using the “Create Gadgets By 
Example” menu 

Steps to Create Gadgets (Cont'd)

Process A Process B

2Cycle Time Mins 2Cycle Time Mins

Process A

2Cycle Time Mins

Process B

3Cycle Time Mins
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2.5Cycle Time Mins2Cycle Time Mins

6. you can make all the gadgets update with change in the 
associated data values by clicking the “Update Gadgets” 
button in the toolbar

The diagram shows the impact of change in the data 
values for the cycle time. 

7. If a gadget fails to update its usually because it is unglued 
from data or has not yet been activated. Problem gadgets 
can be highlighted using the “Gadgets Check On/Off” 
button on the toolbar. 

8. To modify a gadgets scale factor or to color code it you 
need to change the properties of its associated collection.  
Right mouse click on the gadget and select “Manage 
Gadget Collections”

9. Gadget Collections can also be accessed via the toolbar 
“Manage Gadgets” button

Steps to Create Gadgets (cont'd)

eVSM Update Gadgets

eVSM Gadgets Check On/Off

eVSM Manage Gadget Collections

Process A Process B
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To transfer gadgets into a collection, first 
pre-select them, then select the target 
collection from the list and click this button. 

A gadget can only belong to one collection 
so it is removed from its existing collection 
upon transfer

A gadget can only be transferred to a 
collection that has the right gadget type 
(eg. “Bar”)

To modify a gadgets scale factor or to color code it 
you need to change the properties of its associated 
collection.  Right mouse click on the gadget and 
select “Manage Gadget Collections”. 

Gadget Collections can also be accessed via the 
toolbar button

Select a 
collection from 
the list and click 
this button to 
select/highlight 
any gadgets on 
the map that 
belong to it

Managing Gadget Collections

eVSM Manage Gadget Collections
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You can color 
code the gadget 
fill and font 
colors based on 
the value of the 
data to which 
the gadget is 
glued. You can 
also simply 
“inherit” the color 
from the data 
shape or assign 
a color to a 
gadget manually

You can modify 
the scale factor for 
a collection that 
controls gadget 
size in relation to 
data value. Use 
the apply button to 
see the new  
gadget sizes on 
the map before 
exiting the form.

To hide or show 
gadgets in a 
collection, first 
select the 
collection from a 
list and then 
click this button.

Note that the 
collection list 
has a column 
indicating 
visibility status

Modifying and Color-Coding Gadgets
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Example: Cycle Time vs Takt Time 

1. First make sure that the data you wish to visualize with 
gadgets actually exists in eVSM data shapes

2. Drag out a Bar Height Gadget, place it below the first 
activity, and glue it’s flying connector to the Cycle Time 
NVU for the first activity

3. Set the bar’s fill color (blue in above example) and adjust 
the bar width if you like

Steps to draw above example:

Takt TimeCycle Time
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4. Click the Create Gadgets By 
Example in the bar’s right mouse 
button menu

5. Drop a new Bar Height Gadget and attach it’s flying 
connector to the NVU containing the Takt time

6. Align the new gadget with the first gadget collection, and 
adjust it’s width to overlap the whole first collection. In 
above example, color is set to yellow

7. Activate the new gadget with the Activate Gadget 
command in the right mouse menus

8. Open the Manage Gadget Collections form, and make the 
gadget scales for both collections the same via the 
Modify… button

Example: Cycle Time vs Takt Time (cont’d)

Activate Gadget
Create Gadgets By Example
Show Gadget Collection
Manage Gadget Collections
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1. Gadgets have a single size parameter that will scale with 
the data value to which a gadget is glued via the flying 
yellow connector

2. Gadgets are typically glued to NVU, VA or NVA shapes. 
Where gadgets in a collection are glued to data shapes 
with different units, units converters are needed on the 
map to compute the correct scale factors

3. Gadgets have to belong to a collection. They can be put in 
a collection using the Activate Gadget command or by 
transferring them into a collection via the Manage 
Gadgets form.

4. Gadget scale factors and color coding can be controlled 
via the Manage Gadgets form

5. An easy way to create a gadget “set” after creating a first 
gadget is to use the Create Gadgets By Example right 
mouse button menu

6. The Visible switch on the Manage Gadgets form is very 
useful in showing different metrics on the map in a 
presentation environment

7. See the “Examples” section on the eVSM help site 
(www.evsm.com/help) for usage examples of the different 
gadget types

8. A starter set of gadgets is available with eVSM. Additional 
gadgets can be requested by contacting 
support@evsm.com

Gadgets – Key Points
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Standardized Value Stream Maps

eVSM has built-in functions to allow your organization to 
easily draw value stream maps using a standard that you 
define. With standardization, maps can be drawn and 
analyzed faster and can be understood by a wider group. The 
standard comprises of the following:

Standard names for variables and units

A Standard set of Macro Shapes (combinations of shapes) 
that can make drawing maps faster

Blank Starter Maps to ensure consistency and minimize 
effort in starting new maps

Company specific set of icons (eg. Logo, name block, etc.) 
to use in drawing the maps

Standardization Components

Help Movies

These and other short movies on eVSM are available at 
www.evsm.com/help 

Create Macro ShapesManage Names & Units
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Creating a New Standards (Visio Stencil) File

Components of standardization are delivered in a Visio Stencil 
file. To create a new stencil file, click: File > Shapes > New 
Stencil

This will open a new blank stencil. The stencil header bar 
contains a right mouse button menu which allows you to 
name the stencil (via the Properties command) and to save 
it. It is a good idea to include a version number in the stencil 
name. The stencil file should be saved in the C:/Program 
Files/eVSMStandards folder. If this folder does not already 
exist on your machine, then create it.

Copy/paste or drop shapes on the stencil to populate it. Name 
the icon and edit it’s bitmap with the right-mouse menus Edit 
Master > Edit Icon Image. Here is an example of standards 
file content

New Drawing 
Frame

Macro 
Shapes

Standard Variable 
and Unit Names

Standard 
Charts

Corporate 
Logo
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Opening a Standards Stencil File

To open a standards stencil file from a drawing, click

File > Shapes > Open Stencil...

Then navigate to the folder below and select the *.vss file

C:/Program Files/eVSMStandards

Note: A Visio drawing file “remembers” which stencil files 
were open when you last saved it.

If you want new drawings to start with the standards stencil 
already open, then follow these steps:

1. Start a new eVSM drawing by clicking the Start eVSM 
icon on the Desktop

2. Open the standards stencil via “Files >Shapes >Open 
Stencil…”

3. Click File > Save As…, change “Save as type” to 
“Template (*.vst)”, and save the file in the C:/Program 
Files/eVSMStandards folder.

4. Optionally, you can copy the saved *.vst file and paste a 
shortcut for it on the Desktop and/or the Windows Start 
menus. When the *.vst file or the shortcut is clicked, it will 
start a new eVSM map with the standards file
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Managing Names & Units

The Name & Unit Manager (NUM) provides a simple way of 
managing the names and units on a map via this toolbar 
button.

eVSM Name and Units Manager

The purpose of this management environment is:

1. Provide a means to type in a name only once and then 
use it consistently through out the map

2. Provide a means to associate a default unit with a name 
so that when a name is selected, the unit is automatically 
set.

3. Provide a means of creating a starter set of names and 
units for different application areas such as 
manufacturing, healthcare, etc. This will allow a company 
to create standard variable sets and deploy them

The NUM function does not allow editing of names and units 
directly in the data shapes. New names must first be added to 
the NUM form. Then they can be accessed via right mouse 
button menus on the following data shapes.

ValueName Unit

x.xx

Name

Unit

x.xx Unit x.xx Unit

60.00

Hrs

Mins
Long NVU

Short NVU

Value Added Non Value 
Added

Units 
Converter
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Managing Names & Units (Cont’d)

The NUM form is divided in three parts; Sets, Units, and 
Names. Names and units visible in this dialog box represent 
the Current Set. Only the current set names and units are 
available on the right mouse button menus of datasets.

Saved 
Sets

Current 
Set Units

Add New 
Units

Current 
Set Names

Current Set 
Names
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Each name has a default unit. If a new name requires a new 
unit, then the new unit must be created first.

The names and units seen in the NUM form are 
available on the current page only and are stored 
in the NUM shape.

The NUM shape can be copied to other pages or shared with 
team members via a stencil.

Managing Names & Units (Cont’d)

NVU display options are available in the New Name and the 
Modify Name forms.

Optional description 
for variable name

22Cycle Time Secs

27sTakt Time

Normal Display

Multi-Unit Display

Short Display

3Operators Staff

Name 
Unit
Data
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Name & Unit Sets

Sets are used to store collections of names and units.

The whole current set can be saved as a new saved set. 
However, when a saved set is loaded into the current set, it 
does not replace the current set, but instead, adds to it.

Saved sets can be imported/exported to Excel with the Import 
Sets.. and Export Set.. buttons.

To create your own set, just edit the current set so it contains 
only items you want. Then save this as a new set with the 
Save To Set button.

Tag Operation VA NVA Data Data Data Data
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MyNameUnitSet

Saved Sets

Load From Set...

Export Set...

Save To Set...

Import Set...
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Name & Unit Sets (Cont’d)

The saved set can be used on other drawings and files by 
Exporting it to Excel and them importing the Excel file into 
your target drawing.

Names, units, and sets are specific to each page 
and are stored in the Name Unit Manager (NUM)
icon similar to this.

You can copy the saved sets to other eVSM pages or files by 
copy/pasting the NUM icon. If the target page already 
contains an NUM icon, then the sets will be added to those 
already on that page. Sets of the same name will be over-
written.

The NUM icon can also be shared with a company or team 
standardization stencil.

You can edit the standardized list of names and units either 
by export/import to Excel or via the Modify Sets… button. 

Name 
Unit
Data

Saved 
Sets

You can also create a new set in Excel and then import it with 
the Import Set.. button.
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eVSM Macro Maker allows you to create macro shapes. 
Macro shapes are made up of collections of commonly used 
shapes. Macro shapes can really speed up drawing of maps.

The eVSM Macro Maker button is in the eVSM toolbar and 
replaces the “Macro Maker” shape which was in earlier 
versions of eVSM.

eVSM Macro Maker

eVSM Macro Maker

The first time the Macro Maker 
button is clicked, eVSM opens a 
blank Macro Maker stencil

Subsequent clicks of the Macro 
Maker button, creates (or 
replaces) a macro of shapes 
currently selected on the map

The Macro Maker stencil 
is a temporary workspace 
used to create, test, and 
update macro shapes

Only one macro at a time can 
be worked in the Macro Maker 
stencil. Once the macro is 
ready, you move it to the 
desired permanent stencil
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1. Click the eVSM Macro Maker button to open the Macro 
Maker stencil.

2. Select the shapes on the drawing page which you wish to 
include in the new macro.

3. Click the eVSM Macro Maker button. This will create a 
new icon in the Macro Maker stencil. 

4. Name the icon in the Macro Maker stencil.

5. Edit the icon image if necessary via the icon right-mouse-
button menus (“Edit Master > Edit Icon Image”).

6. Test the macro by dragging and dropping it in a map.

7. If needed, make any changes that are required and 
repeat steps 2 to 6.

8. Once your macro shape is ready, move it to your 
permanent stencil.

Steps to Create a New Macro Shape
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5. Select the shapes on the drawing page and click the 
eVSM Macro Maker button on the toolbar. This will 
update the macro in the stencil 

6. Test the updated macro by dragging and dropping it onto 
a map 

7. If needed, repeat steps 4 and 5

8. Once your macro shape is ready, move it to your 
permanent stencil. Remember to delete any older 
versions in the stencil first.

Steps to Edit an Existing Macro Shape

1. If the eVSM Macro Maker stencil is not opened, press 
eVSM Macro Maker button on the toolbar

2. Drag the macro shape you want to edit into the eVSM 
Macro Maker stencil

3. Drag and drop your macro shape from eVSM Macro 
Maker stencil onto the Visio drawing page

4. Make desired changes on the drawing page
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eVSM Macro Maker Do’s and Don’ts

DO use macro shapes to drop common shape 
collections on maps

DON’T  select the shapes and then drag/drop them into 
eVSM Macro Maker stencil

DON’T  place more than one icon within eVSM Macro 
Maker stencil

DO use eVSM Macro Maker button on toolbar to 
initialize eVSM Macro Maker stencil  

DO select shapes then select eVSM Macro Maker 
button on toolbar to make macro shape  

DO delete macro shape from your stencil before you 
drop the edited macro shape back into your stencil  
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Delivery of Standardized Components

The team leader creating the company standard essentially 
creates a collection of files which need to be copied to the 
following folder on each team member’s machine.

C:/Program Files/eVSMStandards

Example files:

acme.vss - standards file (Visio stencil format)
acme.vst - new drawing startup file
readme.txt - can include version number, history, 

any special instructions, etc.

A shortcut on the Desktop (or the Start menus) pointing to the 
acme.vst file is useful for quick access to the standards.

The files can be delivered with manual means such as Email, 
CD, etc. For wider distribution, a setup.exe may be created to 
automatically install the files in the correct location and create 
a shortcut. One way of creating a setup.exe is shown at 
www.evsm.com/v4/selfext
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Standards Update Process

1. Update Standards Files – Team leader updates one or 
more files.

2. Increment Version Number - in the stencil header bar. 
Also update history in the readme.txt file

3. Send to Team – Rebuild installation kit, update 
installation instructions, Email or upload to server

4. Install on Team Machines – Verify update is not already 
installed. Exit Visio and install new version

The new standard is ready for use on new maps. 

If a previously created map needs to be updated, use the 
Compare to Sets.. function in the NUM dialog. This will 
generate a report (in Excel format) of all names and units 
NOT found in the new standard.

Steps to update and deploy the new standards:

The Load buttons will scan the current map or document for 
any names/units which do not exist in the current set and add 
them to the current set.
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Analyzing with eVSM

Transfer to Excel

Help Movies

These and other short movies on eVSM are available at 
www.evsm.com/help 

Calculations in Excel

Working with Units

Equation Manager

Check Glue 
Connections

Fast Update

Multi-lane Processes

The eVSM Calculator

eVSM 
Calculator

Formula Wizard

Tag Operation VA NVA Data Data Data Data

v
a
lu

e
 a

d
d
e
d

n
o
n
 v

a
lu

e
 a

d
d

e
d

c
y
c
le

 t
im

e

d
is

ta
n
c
e

re
w

o
rk

 (
%

)

y
ie

ld
 (

%
)

secs days secs ft % %

A010 Build xx 22.00 5.00 96.00

A020 Hand Cart 135.00

A030 Pack xx xx 22.00 2.00 96.00

Excel

Build

A10

22Cycle Time Secs

96Yield (%) %

Pack

22Cycle Time Secs

96Yield (%) %

A30A20

135

Distance

ft

5Rework (%) % 2Rework (%) %

xx Days

xx Secs xx Secs

Visio

Analyzing with eVSM66 66



Followed by up
to three numeric 
values

One 
alphabetic 
character

The eVSM Calculator button in the toolbar provides bi-
directional transfer of information between the map and a 
spreadsheet. When the button is clicked for the first time for a 
map, eVSM automatically creates a new Excel file and puts it 
in the same folder the Visio file is saved in. The function only 
operates on the current map page

The eVSM Calculator (Cont'd)

Operation 
Tag

Operation Tags

The Operation Tag shape is used to specify 
which activities get synchronized with 
Excel. The tag is glued to any glue-point on 
the activity shape.

As new tags are dropped on the map, their 
number will increment automatically. The 
numbering sequence can be controlled via 
the eVSM Tag Number button. 

Process

A10

eVSM Tag Number

Tag numbers can also be named manually. However, the 
name must be unique and must be in the following format.

Each tagged shape will generate a row in the spreadsheet. 
Any data associated to that shape (via gluing) will appear in 
that row. Excel rows are alphabetically sorted by tag number.

A123
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Only shapes with a grey corner in the stencil can be tagged. 
These are called Excel rowmaker shapes since each of these 
creates it’s own row in the spreadsheet. Row shape 
examples:

Excel Rowmaker Shapes

Operation 
Shapes

Transport 
Shapes

Outside 
Source

Table Transmit 
Shapes

Common Calculator Problems

Missing Data: Data shapes which are not properly 
associated to rowmaker shapes (via gluing) will get missed in 
the data transfer. The following button in the toolbar highlights 
any data shapes which will be missed.

Missing Units Converter: If a variable is used with more 
then one unit, eg. Cycle time in minutes and seconds, then a 
units conversion factor must be provided. See the “Using 
Units Converter” section on how the Units Converter shape is 
used to specify the conversion factor.

eVSM Excel Check On/Off

The eVSM Calculator has some requirements. If these are 
violated, the calculator will stop, display an error message, 
and in some cases, highlight the problem area on the map 
with a red circle.
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All items in a column 
have same units

Rows sorted 
by Operation 
Tag number

One row per 
Rowmaker Shape

Data columns sorted by 
variable name

Data in Excel

Duplicate or Un-glued Tags: Each operation tag on the map 
must have a unique value and must be glued to a valid row 
shape.

Overlapping Data Shapes: Overlapping data shapes where 
some are hidden behind other is not allowed.

Duplicate Data Shapes: Each data shape with in a row 
shape collection must have a unique variable name. 

Grouped Shapes: eVSM Shapes should not be grouped. The 
Calculator will abort if grouped shapes are found.

Common Calculator Problems (Cont'd)
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Calculations in Excel

Equations may be entered in the spreadsheet cells in which 
data shapes are represented. Steps:

The next time the Calculator is run, the result of the equation 
will be displayed in the appropriate data shape on the map. 
The calculated value will be color coded red to show it is 
controlled by Excel.

Select Cell
1

Type “=” followed by 
an equation

Click the Enter button

2

3
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Map.xlsMap.vsd

The Excel file name is copied from  the Visio filename. The 
Excel file is stored in the same folder as the Visio file. Map 
page names in Visio correspond to worksheet page names in 
Excel.

Unit conversion variables in Excel are also scoped by the 
page name.

eVSM relies greatly on the correspondence in names. Map 
names should only be changed using the “Model Copy” 
function

Excel and Visio File Naming

eVSM Calculator

Fast Update

The Fast Update button in the toolbar allows spreadsheet 
update 10x faster than running the eVSM calculator. It is 
active if changes after a calculator run are limited to formulas 
and data values only.

The button is grayed out if it is inactive. It can be activated by 
clicking the eVSM calculator button in the toolbar

eVSM Fast Update
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Visio

Build

A10

22Cycle Time Secs

96Yield (%) %

Pack

22Cycle Time Secs

96Yield (%) %

A30A20

135

Distance

ft

5Rework (%) % 2Rework (%) %

xx Days

xx Secs xx Secs

All eVSM calculations are done via an integrated Excel 
spreadsheet. The spreadsheet is created automatically when 
the “eVSM Calculator” function is invoked. Results from 
calculations in the spreadsheet are automatically displayed on 
the map. eVSM supports two types of equations to perform 
the calculations:

1.Direct Equations – these are formulas entered directly into 
cells in Excel

2.Managed Equations – equations managed by eVSM and 
automatically inserted as formulas in Excel

This section shows the Managed Equations capability in 
eVSM.

Managed equations are created in Visio and stored
in the NUM shape. When the eVSM Calculator is 
run, they generate direct equations in Excel. 

eVSM Equation Manager
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Name 
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Data

eVSM 
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tor
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in Visio
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The Manage Equations form is accessed through the  Name 
and Unit Manager

eVSM Name and Units Manager

eVSM Equation Manager (Cont’d)

List of Managed 
Equations

On/Off switch controls 
whether or not equation 
will be applied when 
Calculator is run
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Creating Managed Equations

In this example, we will set up a managed equation to 
calculate the non value added (NVA) times associated with 
inventory and daily demand. The equation is:

Our goal is to use a single equation for the variable “Non 
Value Added” that is applied everywhere on the map where 
this variable exists. We will assume two key rules of the 
equation manager:

There is only one equation for each target variable name 
(left hand side of the equation)

An equation is either applied to the whole map (when it is 
ON), or not applied at all (when it is OFF)

Non Value Added (Days)   =
Inventory (Units)

Daily Demand (Units/Day)

Steps

1.Click the New Eqn.. button
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Steps (Cont’d)

2. Enter a name and description 
(optional) for equation

3. Select the variable name to calculate and 
it’s corresponding units. This represents the 
left hand side (LHS) of the equation

4. Insert variable for the right hand 
side (RHS) of the equation
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Steps (Cont’d)

5. Select “Parts” for  
variable name and 
units

6. Specify action to take 
where variable is not found 
on map

7. Select the ST option. This specifies how data will 
get get selected from map. The selection is based on 
Operation Tag and explained further in the following 
pages. 

8. Click OK to return to previous form 
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Steps (Cont’d)

9. Type “/” for the divide sign

10. Insert the next variable for the RHS. Here is the 
resulting equation: 

To edit variables in the equation, place the editing cursor 
on the variable and click the Modify Variable.. Button

11. To convert the Managed Equation into Direct 
Equations, click the Calculator        button

ST(Parts,Units,0,APPLY)/UV(Daily Demand,Units,0,SKIP)
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Equation Manager Variables Options

Unique Variable On Map (UV) – Can be used when a 
variable occurs only once on the map, so there is no need to 
specify the operation tag id for it.

Same as Target Tag (ST) – Used to select the RHS variable 
from the same operation tag as the LHS variable.

Named Tag (NT) – Allows you to provide a specific tag id. 
Should be used sparingly because of dependency on fixed 
tag id.

All Tags (ATS) - Selects the RHS variable from every tag on 
map where it exists and makes a list to put in the Excel 
function. Typical usage: sum all VA times.

Downstream Tags (DTS) - Selects RHS variable from the 
next alphabetically sorted tag from the current LHS tag. 
Typical usage: cumulative calculations starting downstream 
and moving upstream such as Downstream Yield(%).

Upstream Tags (UTS) - Selects RHS variable from the prior 
alphabetically sorted tag from the current LHS tag. Typical 
usage: cumulative time or cost calculations.

Range of Tags (RTS) - Selects RHS variable from all tags 
within the range provided. Typical usage: sum all times for the 
A series tags in a swimlane chart.

List of Tags (LTS) - Selects RHS variable from all tags 
supplied in a list
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Block Managed Equations

Each target variable (left hand side of equation) can be 
driven by only one managed equation. When the 
Calculator is run, the managed equation will be applied to 
every instance of the target variable. Sometimes, you 
may want to block the managed equation from being 
applied to some instances of the target variable. This can 
be done with the Block Managed Equation shape.

Block Mng 
Equation

x.xxYield %

x.xx Mins

Simply glue the Block Manage Equation shape to any 
data shape which you want omitted from the managed 
equations calculation.

Note: If the Block Managed Equation shape is attached 
to a data shape AFTER it has already been calculated, 
then you must manually delete it’s direct equation in 
Excel before the next Calculator run, otherwise the OLD 
equation will remain in the spreadsheet.
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xx Unit

22Cycle Time Secs

The “Formula Wizard” button in the toolbar allows an 
alternative method of creating of spreadsheet formulas by 
directly picking items on the map. It also allows 
comprehension of these formulas in eVSM terms.

The function was created to to leverage the practitioners 
familiarity with location of data values on the map as opposed 
to understanding their location on the spreadsheet. It also 
shows contributions to a formula by highlighting the data 
shapes.  

The formula wizard is only active immediately after a “eVSM 
Calculator” run. It is grayed out when inactive.

Formula Wizard

eVSM Formula Wizard

1. First, pick the target shape representing the VA time

In the example below, we are going to set VA=Cycle Time 
for the A10 activity

Using the Formula Wizard to create Excel eqn’s

Process
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D5= 

D5= 

Using the Formula Wizard (Cont'd.)

2. Now click the Formula Wizard button in the toolbar

3. The formula wizard text window shows the Excel cell 
corresponding to the target shape (VA) that was selected

4. Pick the Insert Map Variable button to be able to pick 
data on the drawing for the right side of the formula. 
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D5=E5

xx Unit

22Cycle Time Secs

5. Pick the Cycle Time 
NVU to create the right 
hand side of the formula

A BLUE border on a shape represents the 
Source (Right hand side of the formula)

A GREEN border on a shape represents 
the Target (Left hand side of the formula)

Process

Using the Formula Wizard (Cont'd.)

6. Here is the resulting formula. Click Apply or OK to send it 
to the spreadsheet

7. If the formula needs units converters than they are 
available by picking the Show Units button on the form. 

Remember : The formula behaves exactly as if you typed 
it into the Excel spreadsheet directly. So the units 
corresponding to each data shape are those that the data 
column has in Excel
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D5=E5

9. The Formula Details window shows the same formula in a 
more readable language. This is useful for presentation. 
Note, formulas cannot be edited in this window

Using the Formula Wizard (Cont'd.)

10.Use the summation function to pick a value to be 
summed across the map. For example, if you need the 
sum of the VA times, just click the summation button, then 
select any one VA time shape on the map. eVSM will 
automatically find all the VA time shapes.

11. If the Formula Wizard Icon in grayed out it is because the 
spreadsheet needs to be updated first. Do this by running 
the eVSM calculator.
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12
Max Cycle 
Time

Secs

5
Min Cycle 
Time

Secs5-12Cycle Time Secs

The Model Copy button in the toolbar allows the map and 
associated spreadsheet to be copied to a new page in the 
same Visio file. Very useful in copying an existing map with 
calculations and then making modifications for “what-if” 
studies or Future state possibilities.

Model Copy

eVSM Model Copy

Data Ranges

Data ranges (eg. Cycle time = 5-12 Secs) must be entered in 
separate data shapes as shown below.

Build Build

Numeric Formatting and Cell Fill Color

Raw data values are input in Visio and Formulae are input in 
Excel. Results from Excel calculations are redisplayed on the 
map in Visio.

The results of formula-based values are shown in Red in Visio 
and Excel to distinguish them from Raw  data typed into Visio

Number formats set in Excel for formula-based cells are 
inherited by Visio shapes. Colors of cells in Excel are 
inherited by Visio shapes. Cell colors can be set directly or by 
using  Excels conditional formatting capability

Analyzing with eVSM84 84



This area intentionally left blank

Analyzing with eVSM85 85



Table

This  is a simple starter table that can be further 
customized 

A right mouse click on any of the table cells brings up a 
table modification menu (above) allowing for row / column 
addition and modification

Select Table
View Row and Column Size 
Adjusters
Adjust Table
Clone Row Below
Clone Row Above
Delete Row
Use as Standard Row Height
Clone Column on Right
Clone Column on Left
Delete Column
Use as Standard Column Width

Working With Tables

The eVSM Table shape was introduced to allow easy creation 
of box-score tables on the map

Purpose

Starter Table

Help Movies

These and other short movies on eVSM are available at 
www.evsm.com/help 

Draw Tables Draw Swimlane Charts
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La
ne
 A

La
ne
 B

Picking the “Select Table” right 
mouse menu (above) highlights 
the yellow diamond cell size 
controls. Select the Right Mouse 
Button and the “Adjust Table” 
option AFTER these controls have 
been moved to their new positions

Resizing Rows and Columns

Moving the Table

To move the table to a new position on the map, select a cell 
and then use the right mouse menu “Select Table”. Now just 
drag the table to the new location

Editing Text

Double-Click on a table cell to change its text

Swimla
ne

This table allows swim lanes to be added and deleted using 
the standard table functions. Its important that this be used 
instead of the swim lanes tables provided by native Visio 
because they the latter have  undesirable side effects for 
eVSM shapes

Swim Lane Table
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Current State

1057Capacity

Lead Time 23 days

Future State

2 days

2000

A10

 Each table creates its own worksheet page in the Excel 
Workbook. If the page name is “CS” and the tag is “A10” then 
the worksheet in Excel will be called “CS_A10”

If formulas are created in the cells in the spreadsheet, the 
results of those formulas will appear in the table when the 
eVSM Calculator button is next clicked

Tables and Spreadsheets

You can transfer table cell data to the spreadsheet with the 
“eVSM Calculator button

eVSM Calculator

To transfer the data the table has be first tagged.

Operation 
Tag
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Plotting VSM Charts

Help Movies

These and other short movies on eVSM are available at 
www.evsm.com/help 

XY Charts

XY Charts

Any numeric data available for analysis in eVSM can be 
plotted on a chart such as this.

Cumulative Bar Charts

Milestone Charts

Cross Dock

Assemble

30Cycle Time Secs

1Operators Staff

50Batch Size Pairs

Test

10Cycle Time Secs

1Operators Staff

50Batch Size Pairs

Ship

500Defects ppm

Drill

20Cycle Time Secs

1Operators Staff

50Batch Size Pairs

Sharpen

75Cycle Time Secs

15
Changeover 

Time
Hrs

1Operators Staff

50Batch Size Pairs

Mold Handles

53Cycle Time Secs

2
Changeover 

Time
Hrs

2Operators Staff

50Batch Size Pairs

38500

Scissors

Pairs 27000

Scissors

Pairs 31000

Scissors

Pairs 7000

Scissors

Pairs 5000

Scissors

Pairs75000

Scissors

Pairs

ATLAS 

Warehouse

1

Frequency

Per 
Week

1

Frequency

Per 
Week

MRP

Production

Control

Forecast 30 Days
Weekly Order

Daily

Daily

130.00 Secs

4.17 Days

75.00 Secs

2.14 Days

20.00 Secs

1.50 Days

30.00 Secs

1.72 Days

10.00 Secs

0.39 Days 0.28 Days

Weekly Schedule

Summary

18000Daily Demand Pairs

10.19
Production 
Lead Time

Days

265.00
Processing 

Time
Secs

Daily Ship Schedule

5

Wks

Days

2

Days

Shifts

7.5

Shifts

Hrs

60

Hrs

Mins

60

Mins

Secs

Plant Summary

2.00
No of Shifts 

per Day
Shifts

5.00
No of Work 

Days per Wk
Days

15.00
Production Hrs 

per Day
Hrs

500.00Defects ppm

62.50Raw Materials Hrs

4.17
Finished 
Goods

Hrs

86.25
Work in 

Progress
Hrs

67Takt Time Secs

A10 A20 A30 A40 A50 A60

A70

B10

B20

ACME Scissors

Current State Chart
Maker

Cycle Time - Takt Time Chart
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XY Charts (Cont’d)

Before creating a chart, you must ensure that the data to be 
plotted is:

- Contained in eVSM data shapes
- The data shapes are glued to the parent rowmaker shapes
- Rowmaker shapes are tagged with Operation Tags

Hint: Use the Glue Check and Excel Check buttons in the 
eVSM toolbar to verify,

Steps to Plot XY Charts

1. Drag out the Chart icon from the stencil, place it anywhere 
on the map. 

XY Chart

XY 
Chart

Edit Chart Data
Plot Chart
Create Spreadsheet

Right-mouse click on the shape and select the Edit Chart 
Data command
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2. Set up chart parameters and click Plot Chart button

Steps to Plot XY Charts (Cont’d)

Enter chart title
Select Y-axis unitsSet data filters

Plot. The new chart will 
be placed on bottom left 
hand corner of page. 

Move to require location.

Export chart 
data to Excel

Select data 
variables (eg. 

Cycle Time) to plot

Variables will be plotted in 
sequence shown here. 
Use Up Down buttons to 

change sequence
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Options for Chart Variables:

Select Variables to plot

Set a default value for non-
existent plot points

Select Display Type

eVSM chart is a Group of simple shapes. Avoid ungrouping 
these as this may displace some of the shapes.

Chart is not dynamically linked to data. If data changes, 
chart must be re-created or updated via the Update Chart
command available in the right mouse button menu on the 
chart.

Set color of Fill or lines

Enter Tag number for single tag 
data plot

Notes:

3. Click the Plot Chart command in 
the right mouse button menus Edit Chart Data

Plot Chart
Create Spreadsheet

Steps to Plot XY Charts (Cont’d)

Plotting VSM Charts93 93



Milestone Charts

The milestone chart allows you to plot key milestone on a 
combined timeline.

Steps to Plot a Milestone Chart

1. Get data ready in this format

Sales Milestones

90Order Approved Days

10
Order Shipped 
to Customer

Days

0Order Accepted Days

C180

Manufacturing 
Milestones

80
Manufacturing 

Begins
Days

30
Inspection 
Complete

Days

15
Manufacturing 
Complete

Days

C190
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Edit Milestone Chart Data
Plot Milestone Chart
Create Spreadsheet

Milestone 
Chart

Milestone 
Chart

Steps to Plot a Milestone Chart (Cont’d)

2. Drag out the Milestone Chart icon and click the Edit 
command in it’s right mouse button menus

3. Complete form

4. Plot chart

5. Use the Update chart command in the chart’s right mouse 
button menus to update the chart when the date changes

Update Milestone Tag Chart
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Cumulative Bar Charts

The cumulative bar chart allows you to visualize the phases of 
a value stream on a timeline.

Order Fulfillment 
Timeline

1Process Order Days

8Order Approval Days

3Scheduling Days

15Wait for Mfg Days

10Manufacturing Days

1
Wait for 
Delivery

Days

2Delivery Days

B070

Steps to Plot a Cumulative Bar Chart

1. Get data ready in this format
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Cumulative 
Bar Chart

Steps to Plot a Cumulative Bar Chart (Cont’d)

Edit Milestone Chart Data
Plot Milestone Chart
Create Spreadsheet

2. Drag out the Cumulative Bar Chart icon and click the Edit 
command in it’s right mouse button menus

3. Complete form

4. Plot chart

5. Use the Update chart command in the chart’s right mouse 
button menus to update the chart when the date changes

Update Cumulative Tag Chart
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Kaizen

Map annotation with Kaizen Bursts & Clouds

Adding Attributes to Kaizen Shapes

Problems can be 
documented using 
Kaizen bursts

Solution

Additional attributes can be added to Kaizen Bursts and 
Clouds by selecting the shape with a right mouse click 
and picking the “View Custom Property” menu.

Kaizen

Kaizen 
Cloud

Kaizen 
Starburst

Solutions can be 
suggested using 
Kaizen clouds

Managing Improvements
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The eVSM Kaizen Report toolbar button  scans the map for all 
Kaizen shapes (starburst and clouds) and exports custom 
properties associated with the shapes to two Excel 
spreadsheets (Pagename_Starbursts and 
Pagename_Clouds)

The standard Custom property user interface in Visio allows 
Lean Practitioners or organizations to define their own custom 
properties for export.

This functionality allows export to Excel and via Excel to other 
products like Microsoft Project Manager. The function 
replaces the Visio-based Kaizen table in earlier releases

Note that the export is one-directional and a new report is 
generated every time overwriting any existing report.

C
u
...

Sequence 3

Problem DescriptionProblem

Owner Joe Bloggs

Generating Kaizen Reports

eVSM Kaizen Report

Managing Improvements99 99



Making a Model Copy

The “Model Copy” button in the toolbar allows the map and 
associated spreadsheet to be copied to a new page in the 
same Visio file. Very useful in copying an existing map with 
calculations and then making modifications for “what-if” 
studies or Future state possibilities.

This is also the preferred method of effectively renaming a 
page

eVSM Model Copy
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Visio shapes can simply be selected , copied and then 
pasted into other Microsoft office applications like 
PowerPoint and Excel. Be sure to paste a picture (using the 
Paste As… command). This will allow re-sizing of the 
pasted picture without requiring editing and font 
adjustments.

Copy and Paste into PowerPoint or Excel

Visio Viewer

Acrobat PDF

Sharing with eVSM

A free Visio Viewer is available for download  at: 

http://www.microsoft.com/downloads

Acrobat PDF allows capture of any size drawing in a single 
file, which can be viewed with the free Acrobat Reader, and 
is easily printable. On-screen viewing is good, it is 
searchable, and supports password security. The author 
must have the Acrobat Distiller software, the audience only 
need the free Acrobat Reader. Steps to convert an eVSM 
map to PDF:

1. Click the File>Print... menu.

2. Select Acrobat Distiller as your Printer, and click OK.

3. You will then be prompted for the PDF file name and the 
location to save the PDF file in.
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eVSM maps can be converted to web format which can be 
viewed in any web browser. The web format files can be 
uploaded to a web server or E-mailed. Steps to convert to 
web format:

1. Click File>Save as Web Page…

2. In the Save As dialog. Click, the Publish… button

3. In the Publish dialog, click the Format Options… button, 
set format to GIF, and click OK.

4. To later view this in a web browser, just open the html 
file with the name same as your eVSM filename in a 
web browser.

5. The conversion to web format, creates a collection of 
web files. All of these need to be included in any E-mail 
transfers or upload to a web server. 

6. To open the drawing in a browser, click the 
drawing_name.htm file.

Publish to Web

Convert to Bitmap

Common bitmap formats such as JPEG, GIF, and TIFF can 
be viewed in most browsers without any additional software. 
eVSM maps can be converted to these and other graphic 
formats with the File>Save As… menu. On the Save As 
dialog, click the Save as type pull-down and select the 
format.
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Visio allows drawings of any size. The drawings can then 
be printed on any size paper supported on available 
printers.

When the drawing size does not match the paper size, you 
can either print across several sheets. You can also shrink 
(or expand) the drawing to fit the paper by clicking 
File>Page Setup… and then checking the Fit to 1 sheet
checkbox.

Print
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The File>Print Preview function can and should be used to 
assess the print output before committing the drawing to 
paper.

Print (Cont’d)

Printing Problems

The eVSM Software essentially generates a Visio file. The 
printing of the file is handled by standard Visio functionality. 
Problems printing from Visio could be due to Visio, the print 
driver, or the printer.

Here are some suggestions if you have problems printing 
from Visio:

Make sure you have the latest Visio Service Patch 
installed

Try copy/paste of your VSM to PowerPoint or Excel and 
then print from there

Convert your VSM to Acrobat PDF and then print the 
PDF file
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Toolbar Button Index

Communications Circle 35

eA3 Report 38

eVSM Autofix 25

eVSM Calculator 88,72,71

eVSM Drill Down 27

eVSM Excel Check On/Off 68

eVSM Fast Update 71

eVSM Formula Wizard 80

eVSM Gadgets Check On/Off 45

eVSM Glue Check On/Off 10

eVSM Kaizen Report 99

eVSM Link Activities 24

eVSM Macro Maker 60

eVSM Manage Gadget Collections 46,45

eVSM Model Copy 100,84

eVSM Name and Units Manager 73,55,17

eVSM Tag Number 67

eVSM Unlink Activities 24
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Toolbar Button Index (cont'd.)

eVSM Update Gadgets 45

eVSM V4 Migration 27

Spaghetti Diagram 31
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Icons Index

42,9

79Block Mng Equation

41Callout

97Cumulative Bar Chart

20Finished Goods

41,40Healthcare Depts

41Healthcare Items

41,39Healthcare People

40High Roof Place

40Icon Of Place

19Inventory Shapes

98,41Kaizen Cloud

98,41Kaizen Starburst

28Key Creator

18Long NVU

40Low Roof Place

41Mfg Depts
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Icons Index (cont'd.)

41Mfg People

95Milestone Chart

18Non Value Added

14Operation Shapes

88,67Operation Tag

14Outside Source

41Service Depts

41Service People

19Short NVU

4Start eVSM

15Stepped Arrows

19Supermarket

87Swimlane

86Table

41,21,20Transmit Shapes

41,20Transport Shapes

21Units Converter
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Icon Index (Contd.)

18Value Added

91XY Chart
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Icon Index (Contd.)
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General Index

A

A3 report 38

arrows 15

autofix 25

automove 24

B

bitmap 101

block managed equations 77

blue icons 9

buffers 19

C

calculator problems 66

cell color 82

Chart Maker 88

chart variables 91

communications circle 34

cumulative bar charts 94

current set 56

D

data 16

data ranges 82

direct equations 70

drag & drop 9

drill-down 27

E

enable macros 4

equation manager 70

evsm calculator 65

F

fast update 69

file naming 69

fill color 82

flying connectors 18

formula wizard 78

G

gadget collections 45

Gadget Hide/Show 47

Gadget Color-Coding 47

Gadget Scale Factor 47

gadgets 42

gadgets by example 50

gadgets check 45

glue 10

grid 9

H

help site 5

I

security setting 4
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General Index (cont'd.)

inventory 19

inventory data 19

K

kaizen 96

kaizen cloud 41

kaizen starburst 41

key creator 28

L

lean enterprise academy 6

lean enterprise institute 6

lean healthcare west 6

M

macro maker 60

macro shapes 52

manage equations 71

managed equations 70

managing improvements 96

migrate maps 27

milestone charts 92

model copy 98,82

multi-unit display 22

multi-unit edit 23

N

name & unit sets 58

non value added 18

number format 82

numeric format 82

nva 18

O

operation tag 65

operation tags 65

P

page resize 8

pdf 100

people 39

Plot Charts 88

plot xy charts 89

powerpoint 100

print 102

printing problems 103

Q

queue 19

R

resize page 8

resizing shapes 9

rowmaker shapes 66

S
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General Index (Contd.)

snap 9

snap to grid 9

spaghetti diagram 30

Spaghetti Diagram - Scale 33

spaghetti report 30

standard names 52

standardization 52

starter maps 52

stencil 7

supermarkets 19

support 5

swim lane 85

T

text editing 9

toolbar 5

transmit 20

transport 20

U

unit converters 21

unit family 21

update chart 91

V

va 18

value added 18

visio page names 12

visio viewer 100

W

web 101

X

xy charts 88

Z

zoom 7
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eVSM Demonstration http://www.evsm.com/demo

Download Trial http://www.evsm.com/trial

Check for Latest Updates http://www.evsm.com/updates

eVSM On-line Help http://www.evsm.com/help

eVSM Installation Help http://www.evsm.com/install

eVSM Training http://www.evsm.com/training

Useful URL’s

22 September 2009

Transfer eVSM to new PC http://www.evsm.com/transfer


